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EXECUTIVE SUMMARY 

Today, a growing number of users within and beyond the 
enterprise firewall interact with enterprise applications – such 
as enterprise resource planning (ERP), customer relationship 
management (CRM), and supply chain management (SCM) – to 
facilitate key business processes. Often, these interactions are via 
paper-based forms, such as purchase orders, travel requisitions, 
customer orders, and expense reports. But paper-based forms are 
error-prone, quickly outdated, frequently redundant, and often 
require manual data entry that leads to inaccurate data. To over-
come the drawbacks of paper-based forms, many enterprises have 
implemented online, or Web-based, forms using HTML. However, 
HTML forms have several limitations of their own: they are diffi-
cult to print, cannot be handled offline, and more often than not 
have a different look and feel than paper-based forms, engendering 
confusion and mistakes. 

Given the proliferation of new business processes and the need to 
integrate an expanding population of users into these processes, 
Adobe and SAP have partnered to create a solution that allows 

enterprises to develop interactive forms that are integrated with 
business processes – quickly and easily. The joint solution, called 
the SAP® Interactive Forms software by Adobe, integrates interac-
tive PDF-based forms with business processes that are supported 
by Web-based SAP applications developed and deployed using the 
Web Dynpro development environment framework.1

With SAP Interactive Forms software, personnel change requests, 
cost center change requests, internal requisitions, and online 
recruiting forms can be used to interact directly with business 
processes. The solution provides a bridge between the highly 
structured transaction data stored in enterprise applications and 
the unstructured, document-based information and processes 
that exist inside and outside the enterprise firewall. With this 
direct interaction, enterprises can improve communication and 
collaboration, increase data accuracy, reduce operational costs, 
and ensure the implementation of best practices.

Figure 1: SAP® Interactive Forms Architecture – Runtime

1. In the SAP NetWeaver® platform, SAP Interactive Forms supports the Web Dynpro 
for Java and Web Dynpro for ABAP™ programming language frameworks.
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SOLUTION OVERVIEW

Through a combination of Adobe and SAP technologies, SAP 
Interactive Forms allows enterprises to eliminate redundant and 
inaccurate data and improve the speed with which they can 
respond to customer needs and changing business requirements. 
End users access interactive PDF forms directly from Web Dynpro. 
The forms can be prepopulated with information stored in the 
SAP application based on the user’s role in the business process. 
End users can then add supplementary information or update 
existing information directly in the interactive form – online 
or offline. 

After the user enters data into the form, the data can be validated 
for appropriate format, using client- or server-side validation. 
Also, calculations – such as current interest rate or overtime 
premiums – can be made using Web services or direct application 
programming interface (API) connections with Web Dynpro. 
When the user submits the interactive PDF form back to the SAP 
application, the data is automatically transferred from the form 
to the SAP application using XML. 

Fully integrated into the SAP NetWeaver® 2004 platform,2 
SAP Interactive Forms enables developers to:

Design templates and create interactive forms in the SAP 
NetWeaver Developer Studio tool or the ABAP™ programming 
language workbench using Adobe LiveCycle Designer software
Integrate SAP Interactive Forms with any SAP application
Distribute interactive forms from within SAP applications to 
users for a multitude of business processes, including ERP, 
CRM, and SCM

•

•
•

SAP Interactive Forms is based on the following technology 
components from SAP:

SAP NetWeaver Application Server (SAP NetWeaver AS) 
component – Includes a Java 2 Platform, Enterprise Edition 
(J2EE) engine that contains the Web Dynpro runtime, 
including a server-side, interactive form user interface element 
for executing Web Dynpro with SAP Interactive Forms. SAP 
NetWeaver AS also contains SAP NetWeaver Developer Studio, 
an Eclipse-based development environment for Java that 
enables the creation of Web Dynpro applications containing 
SAP Interactive Forms. SAP Interactive Forms is integrated 
with SAP NetWeaver Developer Studio.
PDF object – An encapsulated object that presents an API for 
Adobe Document Services calls. This API is offered for both 
Java and ABAP.

•

•

SAP® Interactive Forms software by 

Adobe is supported on the following 

server operating systems:

Microsoft Windows 2000 Server/Windows 

Server 2003

Sun Solaris

HP-UX

IBM AIX

Red Hat Linux/Intel

SUSE LINUX/Intel 

•

•

•

•

•

•

2. SAP Interactive Forms is available as part of SAP NetWeaver (through SAP 
NetWeaver AS 6.40). ABAP-based data in SAP R/3® software can be accessed 
from Web Dynpro using technologies such as the SAP Java Connector and 
Adaptive RFC.



SAP Interactive Forms includes the following Adobe technology 
components:

Adobe LiveCycle Designer – A design-time environment for 
creating interactive forms in an easy-to-use, drag-and-drop 
manner. Adobe LiveCycle Designer is fully integrated with 
two proven SAP development environments: SAP NetWeaver 
Developer Studio for the development of Java-based SAP 
applications, and ABAP workbench for the development of 
SAP applications using the ABAP programming language.
Adobe Document Services – A set of runtime services, 
deployed on the SAP NetWeaver AS, that:

Convert XML form templates (created using Adobe 
LiveCycle Designer) to PDF and various print formats
Set Adobe Reader rights to enable users to annotate forms, 
save them locally, and include digital signatures for authenti-
cation using the free and ubiquitous Adobe Reader software
Extract data from SAP applications into SAP Interactive 
Forms and transfer form data back into SAP applications 
using XML
Support certification of form templates to ensure the 
authenticity and integrity of the form template
Enable encryption to ensure the confidentiality and privacy 
of the form3

•

•

–

–

–

–

–

Adobe Reader4 – The universal reader is all that is needed by 
end users to display SAP Interactive Forms at runtime. Forms 
created using SAP Interactive Forms are displayed either in a 
browser using the Adobe Reader plug-in or by the stand-alone 
Adobe Reader.

•
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3. Available in the next release of SAP NetWeaver.
4. Requires Adobe Reader 6.0.2 or higher. 



SAP Interactive Forms allows enterprises to reduce the time 
required to design, manage, and maintain extended forms-
based processes using standards-based, easy-to-use form design 
and deployment tools. Rather than invest in expensive, time-
consuming custom JavaServer Pages development, enterprises 
can use Adobe LiveCycle Designer – embedded within SAP 
NetWeaver Developer Studio – to design and create interactive 
PDF-based forms that are integrated with Web Dynpro. The 
solution enables developers to create interactive online and 
offline forms to support new business scenarios.

Online Forms

In an online form scenario, the user maintains a connection to 
the SAP application – for example, through a company portal. 
The form is filled out by the user and submitted to the server 
in the same online session. The form may also include some 
prefilled information based on the recipient’s name, role in the 
organization, title, and so forth. Here is how an online form 
scenario functions:

Triggered by an end user working in Web Dynpro, Adobe 
Document Services generates an interactive form and 
populates it with relevant application data.
The interactive form is displayed using the Adobe Reader 
plug-in during execution of Web Dynpro in a browser.
Web Dynpro receives the displayed data or completed PDF 
document, the Adobe Document Services extracts the data 
from the PDF file, and the application writes the user-entered 
data to the back-end system.

•

•

•
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DESIGNING, CREATING, AND DEPLOYING INTERACTIVE FORMS 
IN WEB DYNPRO

Figure 2: Online Forms Example
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Offline Forms

In an offline form scenario, the user may download and save the 
interactive PDF form for later data entry and submission. Here is 
an example of an offline form scenario using upload/download 
functions:

The user downloads an interactive form from a Web site to a 
local hard drive.
The form is displayed locally using Adobe Reader.
The user can make changes to the interactive form using 
Adobe Reader.
The user then uploads the interactive form from the local file 
system to the Web site.

•

•
•

•

Alternatively, an interactive form can be sent to a user via e-mail 
from a Java application using the Java Mail API or from an ABAP-
based application using the SAP business communication service. 
Upon receipt of the e-mail, the user saves the form attachment to 
the hard drive and fills it in. Then the user either uploads the form 
using Web Dynpro, as described previously, or submits the form to 
the application via e-mail using the E-mail Submit button included 
in the form.

8

Figure 3: Offline Forms Example
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You can create high-quality, multichannel output (print, fax, 
and e-mail) with SAP Interactive Forms. Because of its superior 
output capabilities, SAP Interactive Forms can also be used for 
forms that require no direct interaction with the user. For 
example, business processes using forms that are entirely prefilled 
by an application and then distributed to recipients – such as 
customer fulfillment or payroll reports – can benefit from the 
easy-to-read paper-like attributes of SAP Interactive Forms.

Here is how document generation functions:
Based on the data received via the business logic (ABAP or Java 
application) and a form template, Adobe Document Services 
merge the forms and their data (in PDF, PostScript, printer 
control language, or Zebra programming language formats). 
The form can then be e-mailed, printed, or faxed to employees, 
partners, or customers.
Outgoing forms can be archived in PDF format for future use.
Using J2EE, developers can e-mail generated forms. Using 
ABAP, developers can e-mail and fax generated forms with 
the SAP business communication service. Forms can also 
be printed using the spool.

•

•
•
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DOCUMENT GENERATION

Figure 4: Document Generation Example 
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This section describes the step-by-step procedures involved in 
creating a simple interactive form within Web Dynpro. 

Defining the Form Elements

The following steps refer to Figure 5:
Within the SAP NetWeaver Developer Studio/Web Dynpro 
perspective, drag and drop the Interactive Form element onto 
the Layout pane.
Select the Interactive Form element in the Outline pane.
Set form properties, such as:

dataSource – Specifies the source of the data to be used in the 
interactive form and encapsulates the data displayed in the 
form at runtime. The path to the context node providing the 
data must also be specified. The structure of the context 
node, which is referenced by the dataSource property, is also 
displayed in the Data View tab of Adobe LiveCycle Designer. 
The corresponding context attributes of this node can be 
bound to Adobe LiveCycle Designer layout elements defined 
in the form.
updateDataInPdf – Enables automatic entry of a data value. 
UpdateDataInPDF is used to update a PDF document with 
the data provided by the data source or to create a new PDF 
document from the data source and the form template if no 
PDF document exists. 
pdfSource – Defines the path of the context element that 
contains the PDF document. This property must be bound 
to a context attribute of the type binary. This property 
allows a developer to access the binary file and download it 
to the local hard disk or read and send the data to a backend.
templateSource – Specifies the unique name of the form 
template. The name is automatically generated when the 
Interactive Form user interface element is inserted into 
the view. 

1.

2.
3.

–

–

–

–
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CREATING A SIMPLE INTERACTIVE FORM USING WEB DYNPRO

Figure 5: Defining the Form Elements
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Form Layout and Binding to the Context

The following steps refer to Figure 6:
Double-click the Interactive Form element to launch Adobe 
LiveCycle Designer.
Drag and drop context elements from the Data View pane to 
the Body Pages pane in Adobe LiveCycle Designer. A text field 
representation of Name appears on the Body Pages pane. 
Set properties, such as marking caption text or defining data 
patterns, in the Object tab and set fonts in the Font tab.

Note: The binding can be checked and changed in the Object tab. 
After the first step, Default Binding is set automatically to the 
corresponding context node $record.PersonalData.Name, but it is 
also possible to add binding manually.

1.

2.

3.
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Figure 6: Form Layout and Binding to the Context
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Integrating Drop-Down Lists

The following steps refer to Figure 7:
Drag and drop a Value Help Drop-down List element from the 
Web Dynpro Library tab to the Body Pages pane in Adobe Live-
Cycle Designer.
Drag and drop context elements from the Data View tab onto 
the Value Help Drop-Down List element. This action binds the 
layout element to the corresponding data source. 
Set the properties of the drop-down list, such as the element 
caption or fonts. 

1.

2.

3.

Note: SAP NetWeaver provides three different drop-down list 
elements in the Web Dynpro Library tab: 

Value Help Drop-Down List – Used when drop-down list 
items are not available at form creation. Values enumerated 
in this type of list are not stored in the form. Item lists can 
be added dynamically by data type modification.
Enumerated Drop-Down List – Used when drop-down list 
items are available at form creation. Values enumerated in 
this type of list are stored in the form. The first list item is 
selected by default when the form is deployed.
Enumerated Drop-Down List (No Select) – Also used when 
drop-down list items are available at form creation, but no 
list item is selected by default when the form is deployed. 

Integrating Check and Submit Buttons

The following steps refer to Figures 8 though 11:
Drag and drop the Check Fields and the Submit to SAP elements 
from the Web Dynpro Library tab to the Body Pages pane in 
Adobe LiveCycle Designer. 
Switch to the corresponding Web Dynpro view and create two 
new actions named CheckPressed and SubmitPressed on the Action 
tab. The corresponding event handlers onActionCheckPressed 
and onActionSubmitPressed are generated.
Click the Layout tab, select the Interactive Form element in the 
Outline pane, and switch to the Properties tab. Select the Check-
Pressed action for the onCheck event and the SubmitPressed action 
for the onSubmit event. 
Add the Java code in the corresponding event handlers. You 
can implement code for server-side checking of the data in 
the form (CheckPressed) or server-side processing of the data 
(SubmitPressed).

Web Dynpro, including the interactive form, can now 
be deployed.

–

–

–

1.

2.

3.

4.
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Figure 7: Integrating Drop-Down Lists
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Figure 8: Integrating Check and Submit Buttons

1

Figure 9: Integrating Check and Submit Buttons

2

Figure 10: Integrating Check and Submit Buttons 

3

Figure 11: Integrating Check and Submit Buttons

4



To help SAP application experts create interactive forms within 
SAP applications, the SAP ERP application includes an ABAP-
based framework called Internet Service Request (ISR). The 
framework guides form designers in creating a consistent look 
and feel for all interactive forms by blending form management, 
business logic, and workflow management in a consistent, logical 
manner. Using SAP Interactive Forms with ISR, you can include 
interactive forms in Java-based Web Dynpro, while the business 
workflow and related events run in the ABAP stack.

Another Java-based SAP workflow tool that allows use of SAP 
Interactive Forms for data capture and exchange is called Guided 
Procedures. Guided Procedures enables users to create forms 
using Adobe LiveCycle Designer and to design the form work-
flow using a browser-based workflow configuration interface. 
Both Java and ABAP back ends can be used, and both online and 
offline forms scenarios are supported.

14

INTERNET SERVICE REQUEST AND SAP GUIDED PROCEDURES



Here are three deployment scenarios that illustrate how SAP 
Interactive Forms can be integrated with business processes.

Enterprise Resource Planning Scenario

A supervisor on the shop floor of a large manufacturer needs to 
order additional parts and materials so that the company can meet 
an unexpectedly large customer order. Traditionally, the super-
visor would find the appropriate paper-based purchase requisition 
form, fill it in by hand, sign it, and send it to the next level of 
management for approval and fulfillment by in-house mail.

Using SAP Interactive Forms, the same supervisor – already 
logged in to the SAP NetWeaver Portal component through SAP 
ERP – accesses the required purchase requisition form on the 
company portal and displays it in PDF format on his or her Web 
browser (see Figure 12). Upon display, the form is prefilled with 
the supervisor’s relevant information, such as name, location, 
and cost center, based on user login.

While remaining logged in to the SAP NetWeaver Portal, the 
supervisor then enters the required information on the purchase 
requisition form. When finished, the supervisor submits the 
form back to the system by clicking the Submit button in the 
form. The data is saved to the application database, and the 
corresponding workflow moves the process to the next step.

15

INTERACTIVE FORMS DEPLOYMENT SCENARIOS 

Figure 12: New Product Request Form



Customer Relationship Management Scenario

A company running a marketing campaign from its SAP 
Customer Relationship Management (SAP CRM) application 
realizes that certain data for an important customer is missing. 
The company sends a sales representative on a customer visit to 
obtain the data. Triggered by SAP CRM, the existing relevant 
customer data is prefilled in the corresponding form, which also 
contains fields for entering the missing data (see Figure 13). The 
form is automatically e-mailed to the responsible sales represen-
tative before his or her scheduled customer visit. The sales repre-
sentative saves it to his or her laptop’s hard drive for later use.

Upon arriving at the customer’s site, the salesperson and the 
customer work together to complete the form. While still at the 
customer’s location, the salesperson prints out the completed 
form for the customer’s records using the print capabilities of 
Adobe Reader. Then, the sales representative forwards the completed 
form to SAP CRM, either by using the E-mail Submit button or 
by uploading the form to the corresponding site in the internal 
company portal upon returning to the office.

SAP CRM receives the data entered by the sales representative, 
processes it, and automatically triggers the next step in the 
business process.

16

Figure 13:  Sales Report Form



Human Resources Management Scenario

An employee wants to fill out a travel request form for an 
upcoming customer visit. Using SAP Interactive Forms, the 
employee logs into the internal company portal, accesses the 
travel request form, and opens it in his or her browser using 
the Adobe Reader plug-in (see Figure 14). The employee can 
complete the form either online or offline. If working online, 
while connected to SAP ERP, the employee fills in the form, 
which has been prepopulated with specific travel guidelines 
based on the employee’s role and location. The employee then 
submits the form to the SAP software for approval or routing 
to the next step in the business process.

Alternatively, if the employee chooses to complete the form 
offline, he or she can save the form to the hard drive, fill in 
the form at a later time, and either submit the form to the SAP 
software or e-mail the form to continue to the next step in the 
business process.
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Figure 14: Travel Request Form

Using SAP® Interactive Forms by Adobe, you can 

do the following:

Exchange data with people and systems via real-time 

information capture in form-based processes

Create powerful XML-based forms without leaving the 

integrated SAP® environment

Offer online and offline access – anytime, anywhere – 

with ubiquitous Adobe Reader client software

Enable users to participate in form-based business 

processes that are intuitive

Create forms that maintain visual integrity and fidelity

Maintain process familiarity to help promote high user 

adoption

Share information with greater control over form security 

inside and outside the firewall

Comply with regulatory requirements related to forms 

and form-based processes

Build interactive electronic forms 

Reduce form design, development, and maintenance 

costs with Adobe LiveCycle Designer seamlessly inte-

grated in the ABAP™ programming language workbench 

and the SAP NetWeaver® Developer Studio tool

Create sophisticated forms with a point-and-click visual 

design tool

Support the Web Dynpro development environment, so 

developers can include interactive PDF forms in intuitive 

Web applications 

Allow nontechnical users to easily create forms, reducing 

the need for custom programming skills

Provide universal access to forms

Reduce IT complexity and costs with Adobe Reader for 

client-side viewing and filling of forms

Enable users inside and outside the firewall to complete 

forms online and offline, and participate in key business 

processes without buying additional software

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•



SAP Interactive Forms allows developers to create interactive 
forms that are integrated with business processes. Developers 
can design, implement, and distribute – and users can access and 
manipulate – SAP Interactive Forms from within or outside of 
SAP applications. Acting as a bridge between highly structured 
transaction data stored in SAP applications, such as SAP ERP and 
SAP CRM, and unstructured form-based information and 
processes, SAP Interactive Forms enables enterprises to improve 
data accuracy, eliminate redundant data and forms, and reduce 
operational costs. Deploying SAP Interactive Forms ultimately 
improves the speed with which enterprises can respond to 
changing customer needs and business objectives.

For more information on SAP Interactive Forms and how it can 
help your business, contact your SAP representative or visit our 
Web site at www.sap.com.
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